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Spring 2017 

 

- Lab 2 - 
 

 

This lab is modified from the ESRI Virtual Campus class “Understanding Map Projections and Coordinate Systems”. 

 

Before beginning the lab exercises: 

1. Download http://faculty.umb.edu/michael.trust/MapProjections.zip. 

2. Unzip the file. 

3. Create a Microsoft Word Document named lab2_yourname.doc. Type the answers to questions and insert 

exported JPG layouts into this Word document.  

 

Exercise 1: Examine Spheroids 

 

In this exercise, you will examine the geography of Long Island, New York, using different spheroids. 

 

Estimated time to complete: 25 minutes 

 

Step 1 - Open the ArcMap document Roundearth\Spheroids.mxd. 

Of the five data layers in the ArcMap document, two are currently displayed (i.e., checked). The Graticule 30 layer consists 

of 30-degree latitude by 30-degree longitude lines using the WGS84 spheroid. The Countries layer shows the generalized 

outlines of world countries using the WGS84 spheroid. 

Three layers are not currently displayed. The Clarke 1866 layer shows a detailed outline of New York using the Clarke 

1866 spheroid. The International 1924 layer shows a detailed outline of New York using the International 1924 spheroid. 

The WGS 1984 layer shows a detailed outline of New York using the WGS84 spheroid. 

 

Step 2 - Zoom in to the area of interest 

Differences in spheroids are not noticeable at scales smaller than 1:5,000,000, so you will need to zoom in to a specific area. 

� From the Bookmarks menu, click Long Island. 

The view zooms into the area around Long Island, New York. 

 

Step 3 - Display a more detailed layer 

The feature shapes in the Countries layer are too generalized to let you see the differences between spheroids. You need to 

use more detailed data. 

� Check the box next to the WGS 1984 layer to display it. 

You see much more detail along the coastline and many smaller islands that weren't visible before. 

 

Step 4 - Compare the spheroids 

� Check the boxes next to the International 1924 and the Clarke 1866 layers to display them. 

� Turn these two layers, along with the WGS 1984 layer, on and off so you can make a visual comparison. 

Depending on the size of your ArcMap window, the current display scale is smaller than 1:5,000,000. At this scale, you 

shouldn't see any differences among the three spheroids. 

 

Step 5 - Zoom in closer 

� Click the check box next to Countries to turn off its display. 

You are interested in the detailed feature shapes around Long Island. 

� From the Bookmarks menu, click Detail 1. 

The view zooms in. Your map scale is probably greater than 1:350,000 and you should just be able to see some differences 

between features as represented by the three spheroids. 

� From Bookmarks menu, click Detail 2. 

Your scale is now probably greater than 1:50,000. The differences between spheroids should be obvious. The Clarke 1866 

and the WGS 1984 spheroids vary the most with the International 1924 spheroid lying approximately halfway between 

them. 

 

Step 6 - Measure the differences 

� On the Tools toolbar, click the Measure tool. The Measure window opens and you can move it as needed. 

� In the Measure window, click the Choose Units button, then choose Distance. 



� From the list of distance units, choose Meters. Now all your measurements will be in meters. 

The map display shows a small island above a horizontal strip of land. 

� Move the mouse pointer over the northernmost point on the small island in the WGS 1984 layer and click 

once. 

� Move the mouse pointer (which looks like a measure tool) over the northernmost point on the small island in 

the Clarke 1866 layer and double-click. 

The distance is reported in the Measure Window. 

� QUESTION 1.1: What is the distance reported in the Measure Window? 

� Click the Pan tool. 

� Move the mouse pointer to the top of the map display. 

� Click and hold the mouse pointer and drag it to the bottom of the display, then release it. The graphic area 

refreshes. 

� Repeat the Pan operation until a land mass comes into view. This is the coastline of Long Island. 

You can use the Pan tool to move the map display in any direction. 

� Use the Pan and Measure tools to examine the coastline of Long Island.  

� QUESTION 1.2: Are the differences uniform throughout the layer? 

 

Note: The datasets for this exercise use different spheroids within the same datum. This may not mean much to you now, 

but it is something you should never do with your database! Part of a datum's definition is its spheroid. We changed 

spheroids solely for educational purposes so we could demonstrate their differences. You will learn about datums later in 

this assignment. 

 

Step 7 - Exit ArcMap 

� From the File menu, choose Exit. Click No when prompted to save your changes. 

 

 

Exercise 2: Compare Map Projections 

 

In this exercise, you will look at several world map projections and see how they distort such spatial properties as 

shape, area, and distance. 

 

Step 1 - Start ArcMap and Open the WorldProjections.mxd. 

The map display shows the world in the Plate Carrée map projection. There are four data layers. The Graticule 30 and 

Countries layers are displayed. The Cities and Tissot's Ellipses layers are not. 

 

Step 2 - Display ellipses 

� Check the box next to the Tissot's Ellipses layer to turn it on. The ellipses are circles. 

In the Plate Carrée projection, the graticule is represented as a grid of squares. Using this projection as a point of reference, 

you will see how other projections distort the shapes of the circles. 

 

Step 3 - Apply a Mercator projection 

� Place the mouse pointer anywhere on the map display then right-click and choose Properties or Data Frame 

Properties. 

� In the Data Frame Properties dialog box, click the Coordinate System tab. 

� Expand the Projected Coordinate Systems folder, then the World folder. 

� Scroll down and click the Mercator (world) projection. 

� Click OK. 

The projection draws in the map display. (The Mercator projection, being cylindrical, theoretically extends forever, but in 

ArcMap the data is trimmed for display purposes.) 

Observe the circles. Equatorial regions have little or no distortion while distortion of the polar regions is extreme. 

� SCREEN SHOT 2.3: Go to Layout View, add a title “SS 2.3 – Mercator”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 4  Apply a Robinson projection 

� In the table of contents, right-click Layers and choose Properties. This is another way to access the data frame 

properties. 

� If necessary, click the Coordinate System tab. 

� Click the following options to apply a Robinson projection: 

* Projected Coordinate Systems 

* World 



* Robinson (world) 

� Click OK. 

� Click the Full Extent button. 

Note the pattern of distortion of the circles. 

� SCREEN SHOT 2.4: Go to Layout View, add a title “SS 2.4 –Robinson”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 5 - Apply an Equidistant Cylindrical projection 

� Open the Data Frame Properties dialog box and, if necessary, click the Coordinate System tab. 

� Click the following options to apply an Equidistant Cylindrical projection: 

* Projected Coordinate Systems 

* World 

* Equidistant Cylindrical (world) 

� Click OK. 

� Click the Full Extent button. 

Note the distortion of the circles and the map features in the corresponding locations. 

� SCREEN SHOT 2.5: Go to Layout View, add a title “SS 2.5 – EqCyn”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 6 - Apply a Bonne projection 

� Open the Data Frame Properties dialog box and, if necessary, click the Coordinate System tab. 

� Click the following options to apply a Bonne projection: 

* Projected Coordinate Systems 

* World 

* Bonne (world) 

� Click OK. 

� Click the Full Extent button. 

Note the distortion of the circles and the map features in the corresponding locations. 

� SCREEN SHOT 2.6: Go to Layout View, add a title “SS 2.6 – Bonne”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 7 - Apply an Equidistant Conic projection 

� Open the Data Frame Properties dialog box and, if necessary, click the Coordinate System tab. 

� Click the following options to apply an Equidistant Conic projection: 

* Projected Coordinate Systems 

* World 

* Equidistant Conic (world) 

� Click OK. 

� Click the Full Extent button. 

Note the distortion. Note also that the central meridian (opposite the cut) runs through Europe and West Africa. 

� SCREEN SHOT 2.7: Go to Layout View, add a title “SS 2.7 – EqCon”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 8 - Modify a predefined projection 

� Open the Data Frame Properties dialog box and, if necessary, click the Coordinate System tab. You can see that 

World_Equidistant_Conic is highlighted as the current map projection. 

� Right-click the name of the highlighted projection and click Copy and Modify…. 

� In the Projected Coordinate System Properties dialog box, click in the Value field for the Central_Meridian 

parameter. Replace the value of 0 with -90.000. 

� Click OK. 

� Click OK in the Data Frame Properties dialog box and click the Full Extent button. 

Note the central meridian. The projection is now centered over North America. 

� SCREEN SHOT 2.8: Go to Layout View, add a title “SS 2.8 – Mod_NA”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 9 - Further modify a projection 

� Open the Data Frame Properties dialog box and, if necessary, click the Coordinate System tab.  

World_Equidistant_Conic is still the current map projection. 

� Right-click the name of the highlighted projection and click Copy and Modify…. 



� In the Projected Coordinate System Properties dialog box, click in the Value field for the Standard_Parallel_1 

parameter. Replace the value of 60 with 30.000. Do the same for Standard_Parallel_2. 

� Click OK. 

� Click OK in the Data Frame Properties dialog box then click the Full Extent button. 

The tangent line (the line of contact between the earth's surface and the cone) is lower on the globe, making the cone 

thinner, its angle greater, and the "V" cutout larger. You will learn more about tangents and standard parallels later in the 

course. 

� SCREEN SHOT 2.9: Go to Layout View, add a title “SS 2.9 – Mod_NA2”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 10 - Display the Cities layer 

� Click the check box next to the Tissot's Ellipses layer to turn it off. 

� Click the Zoom In button. 

� With the mouse pointer, draw a rectangle around the United States to zoom in on it. 

� Check the box next to the Cities layer to turn it on. 

 

Step 11 - Measure the distance from Los Angeles to New York 

� Click the Measure tool Measure tool. 

� Place the mouse pointer on the center of the symbol for Los Angeles and click. 

� Move the mouse pointer to the center of the New York symbol and double-click. 

� QUESTION 2.1: What is the distance from LA to NY? 

 

Step 12 - Change projections and repeat the measurement 

� Open the Data Frame Properties dialog box and, if necessary, click the Coordinate System tab. 

� Click the following options to apply an Equidistant Cylindrical projection: 

* Projected Coordinate Systems 

* World 

* Equidistant Cylindrical (world) 

� Click OK. 

� Measure the distance from Los Angeles to New York again. 

� QUESTION 2.2: What is the distance from LA to NY this time? 

 

Step 13 - Measure the distance with a Mercator projection 

� Open the Data Frame Properties dialog box. 

� On the Coordinate System tab, click the following options to apply a Mercator projection: 

* Projected Coordinate Systems 

* World 

* Mercator (world)  

� Click OK. 

� Once again, measure the distance from Los Angeles to New York. 

� QUESTION 2.3: What is the distance from LA to NY this time? 

 

Step 14 - Exit ArcMap 

� From the File menu, choose Exit. Click No when prompted to save your changes. 

 

 

Exercise 3: Examine aspect for cylindrical projections 

 

In this exercise, you will look at a world Mercator projection in its equatorial, transverse, and oblique aspects. The choice of 

aspect (the orientation of a projection with respect to the earth's axis) for a cylindrical projection largely depends on the 

shape of the area of interest. For areas oriented east to west, an equatorial (normal) aspect is best. For areas oriented north 

to south, a transverse aspect is best. And for areas that run slantwise—like the Hawaiian or Aleutian islands—an oblique 

aspect is best. The reasoning is the same in each case: when the line of contact between the globe and the projection 

surface runs the same way as the area of interest, you minimize distortion. 

 

Estimated time to complete: 20 minutes 

 

Step 1 - If necessary, start ArcMap. Open the map document CylindricalAspect.mxd. 

You see a map of the world with lines of latitude and longitude (spaced at 15 degrees) against a background of the ocean. 

No projection is set. 



 

Step 2 - Apply a Mercator projection 

Make sure that Data Frame 1 is the active data frame (i.e., its name is boldfaced in the table of contents). Hint: To activate a 

data frame, right-click the data frame name and choose Activate. 

� Right-click Data Frame 1 and choose Properties to open its data frame properties. 

� Click the Coordinate System tab then click the following choices to apply a Mercator projection: 

* Projected Coordinate Systems 

* World 

* Mercator (world) 

� Click OK. 

You see the straight parallels and meridians that characterize a cylindrical projection in normal aspect. 

 

The Mercator projection is not really suitable for a world map. It's great for 15 degrees above or below the equator, but 

beyond that, it's stretched out like an old sock. 

 

� Rename the data frame Normal Mercator. (To rename the data frame, select it then right-click and choose 

Properties. Click the General tab and enter a new name.) 

 

Step 3 - Apply a Transverse Mercator projection 

� Activate Data Frame 2. If the data is zoomed too far out, click the Full Extent button Full Extent. 

As with the previous data frame, no projection is set. 

� Open the data frame properties and change the data frame name to Transverse Mercator. 

� Click Apply. 

� Click the Coordinate System tab. A Transverse Mercator projection is not predefined for the whole world, so 

you have to set it up yourself. 

� Click the Add Coordinate System button (the gray globe with the yellow star) and choose New > Projected 

Coordinate System. 

� In the New Projected Coordinate System dialog box, type Transverse Mercator as the name. 

� From the drop-down list of projections, choose Transverse_Mercator. 

� Click Change… in the Geographic Coordinate System section. In the Spatial Reference Properties dialog box 

expand Geographic Coordinate Systems > World and click on ‘WGS 1984’ and click OK. 

� Click OK in the New Projected Coordinate System dialog box and click OK in the Data Frame Properties box. 

� Click the Full Extent button. 

� SCREEN SHOT 3.31: Go to Layout View, add a title “SS 3.31 – TransMer”. Export the layout as a JPG file 

and insert it into your Word document. 

In the Transverse Mercator projection, the line of contact between the globe and the projection surface is the central 

meridian. 

 

In ArcGIS, this projection is limited to 90 degrees of longitude—distortion beyond that range is severe. As with the normal 

aspect, the transverse aspect of the Mercator is best within 15 degrees of its line of true scale. 

 

� Use the Zoom In tool to zoom in on Europe. 

You now have a good conformal map of Western Europe. 

� SCREEN SHOT 3.32: Go to Layout View, add a title “SS 3.32 – Europe”. Export the layout as a JPG file and 

insert it into your Word document. 

 

The Transverse Mercator projection is best-known for its use in mapping the entire world in a series of adjacent strips, 

each of which covers 90 degrees of latitude and 6 degrees of longitude. You'll explore this system, the Universal Transverse 

Mercator coordinate system, in Module 5, Geographic and Planar Coordinate Systems. 

 

Step 4 - Select a location for an Oblique Mercator projection 

� Activate Data Frame 3. 

� If necessary, click the Full Extent button. 

 

As before, no projection is set. 

 

For an oblique aspect of the Mercator projection, you want a region with a slantwise orientation. In this case, Central 

America will do. 

� From the Bookmarks menu, click Central America. 

� Click the Add Data button Add Data button. 



� Navigate to your Aspect folder and add Central American Cities.lyr. 

 

Rather than labeling the cities, you'll use map tips to identify them as needed. Map tips, which appear when you mouse 

over a feature on the map, provide a quick way to see the name of a feature or a particular piece of information about it, 

without having to use the Identify tool (which gives you all of a feature's attributes when you click on it). 

� On the Tools toolbar, click the Select Elements tool (the black arrow). 

� Move the mouse pointer over the city in the upper left corner of the display to see that it's San Diego. 

� Now move the cursor to the lower right corner of the display and find Panama City. 

� Right-click the Central American Cities layer and choose Open Attribute Table. 

� Scroll to the right in the table. When you apply the Oblique Mercator projection in the next step, you will use 

the latitude-longitude values to define an oblique line of true scale between San Diego and Panama City. 

� Close the attribute table. 

 

Step 5 - Apply an Oblique Mercator projection 

� Open the data frame properties, click the General tab, and change the data frame name to Oblique Mercator. 

� Click Apply. 

� Click the Coordinate System tab. 

� Click the Add Coordinate System button and choose New > Projected Coordinate System. (As with the 

Transverse Mercator, the Oblique Mercator is not predefined in ArcGIS.) 

� In the New Projected Coordinate System dialog box, type Oblique Mercator as the name. 

� From the drop-down list of projections, choose Hotine_Oblique_Mercator_Two_Point_Natural_Origin. 

� For the latitude of the first point (San Diego), type 32.76. 

� For the latitude of the second point (Panama City), type 9. 

� Make the longitude of the first point -117.12. 

� Make the longitude of the second point -79.51. 

� Make the latitude of center 21. (This is about midway between the latitudes of the two cities.) 

� Click Change… in the Geographic Coordinate System section. In the Spatial Reference Properties dialog box 

expand Geographic Coordinate Systems > World and click on ‘WGS 1984’ and click OK. 

� Click OK on the New Projected Coordinate System dialog box and click OK on the Data Frame Properties box. 

 

The line of contact between the globe and the projection surface (tangent) runs roughly along the red line in the graphic 

(not drawn on the actual map). 

� SCREEN SHOT 3.5: Go to Layout View, add a title “SS 3.5 – ObMer”. Export the layout as a JPG file and 

insert it into your Word document. 

 

The Hotine Oblique Mercator is one of several oblique Mercator projections based on different formulas. The Hotine 

version, developed by the English geodesist Martin Hotine, is the one implemented in ArcGIS® Desktop. There are four 

variations of the projection in ArcGIS. You can set the line of true scale either by specifying two points that the line passes 

through or by specifying a single point and an azimuth value (that is, an angle of obliqueness). Both options give you a 

choice of where to set the origin of the projected coordinates. This can be either where the line of true scale intersects the 

equator or where it intersects the central latitude of the projection. 

 

Step 6 - Save and close the map 

� Save the document with a new name (lab2_ex3_yourname.mxd) in your Aspect\MyWork. 

 

 

Exercise 4: Examine Aspect for Planar Projections 

 

In this exercise, you will look at an Azimuthal Equidistant projection in its normal, transverse, and oblique aspects. The 

valuable property of this projection is that it preserves true distance and true direction from a single point to any location 

on the map. Your choice of aspect is determined by your point of interest. This projection is probably most often used for 

polar maps, but can be used for a map centered on any important point. Since it has no east–west or north–south bias, it 

can also be used to map landmasses, like Asia, that spread fairly equally in all directions. 

 

Because any line drawn from the center of the projection follows a great circle, the Azimuthal Equidistant projection is 

good for showing shortest-distance paths, like those followed by radio waves. Since it preserves true distance, it is also 

good for plotting ranges, such as the range of an airplane from a base, or the decay rates of light or noise from a source. 

 

Estimated time to complete: 25 minutes 

 



Step 1 - If necessary, start ArcMap. Open the map document PlanarAspect.mxd. 

The map document has three data frames, one for each aspect of the projection. The Azim Equidistant Equatorial data 

frame is active, but the projection has not been set. 

 

Step 2 - Apply an Azimuthal Equidistant projection 

� Make sure that Azim Equidistant Equatorial is the active data frame. 

� Open its data frame properties and click the Coordinate System tab. 

 

The Azimuthal Equidistant projection is not predefined, so you will set it up yourself. 

� Create a New Projected Coordinate System. 

� In the New Projected Coordinate System dialog box, type Azimuthal Equidistant as the name. 

� From the drop-down list of projections, choose Azimuthal_Equidistant. 

� Set the geographic coordinate system to World > WGS 1984. 

 

The point where the globe contacts the projection plane, from which all distances and directions are true, is defined by the 

intersection of the central meridian and the latitude of origin. In this case, you'll use the prime meridian and the equator. 

Since the tangent, or contact point, lies on the equator, the aspect is equatorial. 

� Click OK in the New Projected Coordinate System dialog box and click OK in the Data Frame Properties dialog box. 

� If necessary, click the Full Extent button. 

 

Since distances measured from the center are true, you should be able to measure east and west along the equator (or, 

more simply, from one end of the equator to the other) and find the earth's circumference. Your results won't be exact, 

because the Measure tool is not precise at small scales, but they should be fairly close. 

 

� QUESTION 4.1:  What is the earth's circumference at the equator in meters? 

Hint: Using the Measure tool, click one end of the equator then drag the mouse to the other end of the equator and 

double-click. Note the measurement along the bottom of the ArcMap window. 

 

Step 3 - Apply a polar aspect 

� Activate the Azim Equidistant Polar data frame. 

� If necessary, click the Full Extent button. 

 

As before, no projection is set. 

� Open the data frame properties and click the Coordinate System tab. The polar (normal) aspect of this projection is 

predefined for both poles. 

� Click the following choices to apply the projection to the south pole: 

* Projected Coordinate Systems 

* Polar 

* South Pole Azimuthal Equidistant 

� Click OK then click the Full Extent button. 

� SCREEN SHOT 4.3: Go to Layout View, add a title “SS 4.3 – SP AzEq”. Export the layout as a JPG file and insert 

it into your Word document. 

 

The Azimuthal Equidistant projection does not preserve shape or area. Within 30 degrees of the center (the area around 

Antarctica), shape and area distortion is minimal. Within 90 degrees (the area along the equator), it is moderate. Beyond 

that, it is extreme. 

 

� QUESTION 4.2: The group of predefined polar projections includes Azimuthal Equidistant, Lambert 

Azimuthal Equal Area, Gnomonic, Orthographic, and Stereographic. Which type of projections are these? 

Conic 

Cylindrical 

Planar 

None of the above 

 

Step 4 - Select a point for an oblique aspect 

� Activate the Azim Equidistant Oblique data frame. 

� If necessary, click the Full Extent button. 

 

The Azimuthal Equidistant projection has already been set, but the aspect is equatorial. The data frame includes a layer of 

selected world cities. 



� Right-click the Cities layer and choose Open Attribute Table. 

� Scroll to the right. 

 

The table contains latitude and longitude values (in decimal degrees) for each city as well as the distance in kilometers to 

each of the other cities. The distance values are great circle distances taken from a table in the National Geographic Atlas of 

the World (7th edition). 

 

� Scroll to the bottom of the table and make a note of the latitude and longitude for Caracas. 

You'll center the projection on this point. After applying the projection, you'll measure distances from Caracas to some 

other cities and compare your results to the table. 

� Once you have noted the latitude and longitude values for Caracas, close the table. 

 

Step 5 - Apply an oblique aspect 

� Open the data frame properties and click the Coordinate System tab, if necessary. 

� Click Modify. 

� In the Projected Coordinate System Properties dialog box, highlight the value for Central_Meridian and type -66.9. 

� Highlight the value for Latitude_Of_Origin and type 10.5. 

� Click OK on the Projected Coordinate System Properties dialog box. 

� Click OK again on the Data Frame Properties dialog box. 

� If necessary, click the Full Extent button. 

 

Caracas, Venezuela is now the point where the globe contacts the projection plane. 

� SCREEN SHOT 4.5: Go to Layout View, add a title “SS 4.5 – Caracas Ob”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 6  Measure distances 

� In the Map Scale box, type 150,000,000 then press Enter. 

� Change the display from Meters to Kilometers and click OK. Otherwise, click the Measure tool and set the distance 

units to Kilometers. 

� Use the Measure tool to measure the distances from Caracas to a few other cities such as Honolulu, Cape Town, and 

Rome, and make a note of your results. (Hint: You may need to zoom out first.) 

� QUESTION 4.3a: What are the distances you measured from Caracas to Honolulu, Cape Town, and Rome? 

� Open the Cities attribute table. 

� Scroll to the bottom to find the record for Caracas, then scroll to the right and look for the distances to the cities 

you measured. 

� QUESTION 4.3b: What are the distances in the table from Caracas to Honolulu, Cape Town, and Rome? 

 

Your results won't match the table values exactly, (again, the Measure tool is not precise at small scales), but they should be 

very close. 

 

� Move the table aside. 

� Now make a few measurements between cities other than Caracas: from Montreal to Cairo or from Rio to London. 

� QUESTION 4.3c: What are the distances you measured from Montreal to Cairo, and Rio to London? 

� Move the table back to the center of the screen and check your results. 

� QUESTION 4.3d: What are the distances in the table from Montreal to Cairo, and Rio to London? 

You should find that your values are pretty far off, probably by several hundred kilometers. Azimuthal projections give true 

distances only from the center, which in this case you set to Caracas. 

 

� When you're finished, close the table. 

 

Step 7  Save and close the map 

� Save the document with a new name in your Aspect\MyWork folder. 

 

Exercise 5: Examine perspective – (removed from this assignment) 

 

Exercise 6: Choose Projections 

 

In February, 1519, the Spanish conquistador Hernan Cortes and about 400 men sailed from Cuba to Mexico. They 

established a camp near modern Veracruz, and marched from there to the Aztec capital Tenochtitlan, on the site of modern 

Mexico City. 



 

The Spanish were vastly outnumbered in their war of conquest against the Aztecs, but horses, guns, and a smallpox 

outbreak worked in their favor. They also benefited initially from the Aztec religious belief in the return of a white god 

from the east. Probably most important was the enmity of other Indian groups toward the Aztecs, which Cortes skillfully 

exploited. After long political intrigues and fierce battles, the Spanish conquered Tenochtitlan in August, 1521. 

 

In this exercise, you will choose projections for three maps related to the theme of the Spanish conquest of Mexico. A globe 

will be helpful.  

 

Estimated time to complete: 25 minutes 

 

Step 1 - If necessary, start ArcMap. Open the map document Distortion\ChooseProjections.mxd. 

 

Your first map will be a general reference map, orienting map readers to the geographic relationship between Mexico, 

Cuba, and the islands of the Caribbean. Remember that in choosing a projection, you want to take into account the map's 

purpose and the shape of the area of interest. General reference and atlas maps typically try to balance shape and area 

distortion. At the scale of continents and smaller regions, this is done with equidistant projections—projections that 

maintain true scale along meridians. So an equidistant projection is a good choice for this map. 

 

Having decided on a projection type, you next consider the shape of your map extent. (Hint: A globe will help here). The 

latitude of the area of interest extends from 5°N to 35°N and the longitude from 60°W to 120°W. The apparent east–west 

orientation of this area in the map document is a bit deceptive. ArcMap puts unprojected data into an equirectangular 

projection for display purposes, and this causes an east–west stretching of shapes as you move away from the equator. 

(Measurements and calculations, however, are accurately based on the underlying spheroid.) 

 

You're looking for a projection that is both equidistant and azimuthal—that would be the Azimuthal Equidistant. Azimuthal 

maps are always focused on a particular point, from which the distortion pattern radiates outward. The natural focal point 

for this projection is 20°N, 90°W, in the middle of the area of interest. 

 

Step 2 - Define a custom Azimuthal Equidistant projection 

� Open the data frame properties and click the Coordinate System tab. 

 

The current coordinate system is a spherical coordinate system based on the WGS84 spheroid. 

� Click New and choose Projected Coordinate System. 

� In the Name box at the top of the dialog box, type Projection for Mexico and the Indies. 

� From the Name drop-down list, choose Azimuthal_Equidistant. 

� Set the central meridian parameter to -90. 

� Set the latitude of origin parameter to 20. 

� Click Select to pick a geographic coordinate system. In the Browse dialog box, double-click the World folder. 

� Click WGS 1984.prj then click Add. 

 

Note: Based on your selection of the geographic coordinate system, the central meridian and latitude of origin values you 

entered have been modified slightly. 

 

Step 3 - Apply the projection 

� Click OK in the New Projected Coordinate System dialog box. 

� Click OK again in the Data Frame Properties dialog box. 

� In the table of contents, right-click the Area of Interest layer and choose Zoom to Layer. 

� SCREEN SHOT 6.3: Go to Layout View, add a title “SS 6.3 – Custom AzEq”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Unless you've adjusted your ArcMap window, there is probably too much geography showing outside your area of interest. 

You will adjust the dimensions of your data frame to match the area of interest more closely. 

 

Step 4 - Adjust the data frame dimensions 

� Open the data frame properties and click the Data Frame tab. Be sure Extent is set to Automatic. 

� Check the Enable box toward the bottom of the dialog box. This box lets you match the data frame proportions to 

the extent of a layer or to some other shape. 

� Click Specify Shape. 

� In the Data Frame Clipping dialog box, click Custom Extent. 



The values display in decimal degrees, which are the native map units of the data. 

� Set the top to 35, the bottom to 5, the left to -120, and the right to -60.  

These are the bounding coordinates of your area of interest. 

� Click OK in the Data Frame Clipping dialog box. 

� Click OK again in the Data Frame Properties dialog box. 

� In the table of contents, turn off the Area of Interest layer and the Graticule layer. 

� SCREEN SHOT 6.4: Go to Layout View, add a title “SS 6.4 – Custom AzEq2”. Export the layout as a JPG file and 

insert it into your Word document. 

 

This is your finished reference map. It's not really finished—it needs labels, a scale bar, and so on—but for this exercise, 

you're only interested in the projection. 

 

Contrary to our hypothesis, the Equidistant Conic projection seems to manage distortion better within the area of interest. 

This is true, at least, by the straightforward criterion that the maximum distortion in the area of interest never exceeds four 

percent for the Equidistant Conic, while for the Azimuthal Equidistant, it does exceed four percent around the corners of 

the rectangle. Of course, you could make the analysis more complex. For example, you might consider how much of the area 

of interest has less than one percent distortion; you might rate distortion values over land differently from distortion 

values over water, and so on. 

 

Step 5 - Make a new data frame active 

� Collapse the table of contents for the Mexico and the Indies data frame. 

� Right-click the Aztec Empire data frame and click Activate then expand its table of contents. 

 

In 1519, the Aztec empire was at its height. The map shows its extent in relation to the rest of Mesoamerica. (Mesoamerica, 

extending from central Mexico to Guatemala—and including the Yucatan peninsula—is the region in which Native 

American civilizations flourished between 1000 BC and 1521 AD.) 

 

This map's main purpose is area comparison—to show how much land in Mesoamerica was controlled by the Aztecs. Since 

this purpose will be undermined if the map distorts area, you should choose an equal area projection. The shape of your 

area of interest is somewhat problematic. When you want an equal area conic projection, and the area of interest lies more 

or less east–west, use the Albers Equal Area Conic. To customize it for your area of interest, you'll set the central meridian 

to 97°W and the standard parallels to 15°N and 23°N. 

 

Step 6 - Define a custom Albers Equal Area Conic projection 

� Open the data frame properties for the Aztec Empire data frame then click the Coordinate System tab. 

� Click New and choose Projected Coordinate System. 

� For Name, type Projection for Mesoamerica. 

� From the Name drop-down list, choose Albers. 

� Set the central meridian to -97. 

� Set the first standard parallel to 15. 

� Set the second standard parallel to 23. 

� Click Select to pick a geographic coordinate system. 

� In the Browse dialog box, double-click the World folder. 

� Click WGS 1984.prj and click Add. 

 

Step 7 - Apply the projection 

� Click OK in the New Projected Coordinate System dialog box. 

� Click OK in the Data Frame Properties dialog box. 

� Pan the display slightly if it helps to center the Aztec Empire in the ArcMap window. 

� SCREEN SHOT 6.7: Go to Layout View, add a title “SS 6.7 – Custom AlbEAConic”. Export the layout as a JPG 

file and insert it into your Word document. 

 

This is your finished map of the Aztec Empire at the time of the Spaniards' arrival. 

 

Step 8 - Make a new data frame active 

� Collapse the table of contents for the Aztec Empire data frame and activate the Cortes's Route data frame then 

expand its table of contents. 

 

The white arrows show the course Cortes sailed from the town of Santiago de Cuba to the settlement he founded at 

Veracruz. (Hint: Towns are not labeled, but map tips are turned on so you can identify towns by mousing over them.) 



 

Step 9 - Zoom in on the map 

� From Bookmarks menu, click Land Route. 

 

Cortes left Veracruz in June, 1519, following the route shown to Tenochtitlan, where he arrived in early November. (Again, 

you can mouse over point features to identify them.) 

 

Inside the city, Cortes held the Aztec emperor Montezuma hostage for several months. Driven out of the city by an Aztec 

revolt in June, 1520, during which Montezuma was killed, the Spaniards, having suffered heavy losses, retreated about 

halfway to the coast. They regrouped and marched again on the capital in December of that year. After a prolonged siege 

that largely destroyed the city, Tenochtitlan fell in August with the capture of the last emperor, Cuauhtemoc. 

 

Step 10 - Zoom to the full extent 

� From the Bookmarks menu, click Overview. 

The bounding longitudes of the area of interest are about 75°W and 100°W, so you'll set the central meridian in between 

these values. The bounding latitudes are 15°N and 25°N, so you'll set your standard parallels a couple of degrees inside 

these lines. 

 

Step 11 - Define a custom Lambert Conformal Conic projection 

� Open the data frame properties for the Cortes's Route data frame and click the Coordinate System tab. 

� Click New button and click Projected Coordinate System. 

� For Name, type Projection for Cortes's Route. 

� From the Name drop-down list, choose Lambert_Conformal_Conic. 

� Set the central meridian to -87.5. 

� Set the first standard parallel to 17. 

� Set the second standard parallel to 23. 

� Click Select to pick a geographic coordinate system. 

� In the Browse dialog box, double-click the World folder. 

� Click WGS 1984.prj and click Add. 

 

Step 12 - Apply the projection 

� Click OK in the New Projected Coordinate System dialog box. 

� Click OK again in the Data Frame Properties dialog box. 

� SCREEN SHOT 6.12: Go to Layout View, add a title “SS 6.12 – Custom LCConic”. Export the layout as a JPG file 

and insert it into your Word document. 

This is your finished map of the Cortes's route. 

 

The Lambert Conformal Conic works nicely. The whole area of interest is well within the one-percent distortion range. In 

fact, area distortion is about one half of one percent at the upper and lower boundaries of the blue rectangle. Between the 

standard parallels, area has less than true scale; outside the standard parallels, it has greater than true scale. This 

projection choice is much better than a modified Mercator. Don't use a Mercator projection with a modified standard 

parallel unless you are working at a very large scale or unless the standard parallel is only moved very slightly away from 

the standard line of true scale. 

 

Step 13 - Save and close the map 

� Save the document with a new name in your Distortion\MyWork folder. 

 

Exercise 7: Define a geographic coordinate system for the moon – (removed from this assignment) 

 

Exercise 8: Determine and assign coordinate systems 

 

When a dataset has no coordinate system information (or the information is wrong) the data is almost unusable. You might 

be able to draw, symbolize, and label the layer, but you can't make valid measurements or comparisons to other layers. 

 

When you come across data like this, you try to find out about it. You look for metadata files in the same folder or nearby 

folders. You look for any .txt, .xml, .prj, or readme files that might contain coordinate system information. You look for the 

CD that contains the data or the Web site from which it was downloaded. You ask coworkers if they know of any files or 

hard copy documentation. 

 



In this exercise, you'll work with two datasets that have no coordinate system information. First you'll determine their 

coordinate system, Then you'll use ArcGIS to add this information permanently to each data source. 

 

Estimated time to complete: 30 minutes 

 

Step 1 - Find the coordinate system information for the streets shapefile 

Suppose you have data and you don't know its coordinate system. For many of you, this may not be too hard to imagine. 

 

The first data source you want to work with is named Streets. You go to a coworker who tells you that your company 

documents each piece of GIS data it uses in a logbook. You get the book, look up Streets, and find out that it originally came 

from the U.S. Census Bureau shapefile and has been in use for years. The logbook also tells you that the GCS is NAD27. 

 

Given this information, you can now use ArcCatalog to define the spatial reference for this shapefile. 

 

Step 2 - Using ArcCatalog copy the streets data 

To be on the safe side, you'll make a copy of the shapefile and leave the original one alone. 

� In the ArcCatalog tree, navigate to the Datums\AssignCS folder. 

� Copy Streets27NoPrjFile.shp to your Datums\MyWork folder and rename it Streets.shp. 

 

Step 3 - Assign a spatial reference 

� In the catalog tree, right-click Streets.shp and choose Properties. 

� Click the X,Y Coordinate System Tab. 

� Click Select. 

� In the Browse dialog box, open the Geographic Coordinate Systems folder then the North America folder. 

� Click North American Datum 1927.prj to select it. 

� Click Add. 

 

The coordinate system is now set to GCS_North_American_1927. 

 

� Click OK in all open dialog boxes. 

 

The Streets shapefile now has an additional file called Streets.prj that contains its coordinate system information. Next, you 

will locate and examine this file. 

 

Step 4 - Examine spatial reference metadata 

� Open Windows Explorer and navigate to your Datums\MyWork folder. 

 

The shapefile is composed of seven files with different extensions. You just created the Streets.prj file when you defined the 

spatial reference in ArcCatalog. 

 

� In the Windows Explorer tree, click the AssignCS folder. 

 

Streets27NoPrjFile has all the same files as Streets, except that it has no .prj file. The Hydrants shapefile also has no .prj file. 

 

Step 5 - Look at a .prj file 

� In the Windows Explorer tree, click the Datums\MyWork folder. 

� In the display (right-hand panel), right-click Streets.prj then click Open With or Open. 

� If you see a message warning you that Windows cannot open the file, click the "Select the program from a list" 

option and click OK. 

� In the Open With dialog box, choose a text editor like WordPad or Notepad, but make sure that the "Always use 

this program…" box at the bottom of the dialog box is unchecked. 

� Click OK. 

 

A .prj file is a text file. In this one, you see one long line formatted to store the parameters of the Streets GCS: the datum 

(which includes the spheroid), the prime meridian, and the angular unit of measure. 

Now when you add the Streets shapefile to a map, ArcMap can read this .prj file to determine the coordinate system. 

 

� Close the Streets.prj text file window. 

 

Next you'll turn your attention to the Hydrants shapefile. 



 

Step 6 - Add the Hydrants layer to ArcMap 

� If necessary, start ArcMap and open a new map document. 

� From the View menu, choose Data View. 

� Click the Add Data button, navigate to the Datums\AssignCS folder and add Hydrants.shp. 

� If you get a warning message, click OK. 

� Open the Data Frame Properties dialog box and click the Coordinate System tab. 

 

The coordinate system of the data is unknown. A note tells you that the data cannot be projected. 

� Click Cancel on the Data Frame Properties dialog box. 

 

Once again, you're working with undefined data. This time, however, when you go to the GIS logbook, the dataset isn't 

listed—it's too new. None of your coworkers know what the coordinate system is, but someone suggests that maybe the 

data came from the city fire department. 

 

You call the fire department and learn that some university students were involved in a project using GPS units to digitize 

the city's newest fire hydrant installations. Unfortunately, the students and their professor have since moved on without 

leaving any way to reach them. 

 

You don't have metadata. You can't contact the data provider. Your last resort is to examine the data itself and try to 

identify its coordinate system. To do this, you'll add a different dataset that covers the same geographic area and project it 

into a PCS you want to test. If the coordinates match, you've found the right PCS. 

 

Step 7 - Examine coordinates for the hydrants layer 

� In the ArcMap display, move your mouse over a fire hydrant and read the coordinates in the status bar. 

 

You see X-coordinates over 400,000 and Y-coordinates over 3,700,000. These are definitely not latitude-longitude 

coordinates.  Now you have to do some investigating to compare these numbers with numbers in some of the more 

common projected coordinate systems used by your organization. 

 

Note: 

Datasets will display together (apparently "align") as long as their coordinate values are in the same range. Given a 

projected dataset, like the hydrants shapefile, you could take another dataset from a totally different part of the world, put 

it in an arbitrary map projection, and make the two datasets line up—all you have to do is set your projection parameters 

so that the second dataset has coordinate values similar to the hydrants. 

 

Conversely, it would be possible to add a dataset from the same geographic area and in the same map projection as the 

hydrants and nevertheless find that the two datasets did not display together—this would occur if their coordinate system 

origins or false easting and northing happened to be set differently. 

 

In order to play the match game, you need to work with datasets that are known to occupy the same geographic space. 

Furthermore, you can only reliably test for PCSs that have explicitly defined projection parameters, such as the Universal 

Transverse Mercator and State Plane Coordinate systems. 

 

Step 8 - Insert a data frame and set its spatial reference 

The most commonly used coordinate system in your organization is the State Plane Coordinate system, specifically the 

NAD27 version. 

� In ArcMap, from the Insert menu, choose Data Frame. 

� Right-click anywhere in the empty ArcMap display and click Data Frame Properties or Properties. 

� In the Data Frame Properties dialog box, click the Coordinate System tab. 

� Expand the Projected Coordinate Systems folder > State Plane > NAD 1927 (US Feet). 

� Scroll down and click NAD 1927 State Plane California V FIPS 0405. (This zone covers Kern, Los Angeles, San 

Bernardino, San Luis Obispo, and Ventura counties in southern California.) 

� Click OK to close the Data Frame Properties dialog box. 

 

The ArcMap display doesn't look any different because there's still no data in the data frame. 

 

Step 9 - Add a layer to the data frame 

� Click the Add Data button, navigate to your module Datums\MyWork folder and add Streets.shp. 

� Move your mouse over the display and note the coordinates in the status bar. 



 

The x-coordinates are in the range of 2,200,000 and the y-coordinates are around 200,000. These numbers do not match 

the coordinates of the Hydrants layer (around 1,000,000 for the x-values and 3,700,000 for the y-values). You can be sure 

that this is not the correct PCS. The second most common PCS that your organization uses for data in your area is the 

Universal Transverse Mercator system—specifically, UTM Zone 11 North. 

 

Step 10 - Change the spatial reference 

� Open the Data Frame Properties dialog box and click the Coordinate System tab, if necessary. 

� Expand Projected Coordinate Systems > UTM. 

 

Here there are several choices. Remember that in this situation you're picking not only a PCS but also a GCS. You'll pick 

WGS84 because it is the datum typically used by GPS units, and that is how the hydrants data was collected. 

 

� Expand WGS 1984 > Northern Hemisphere and then click WGS 1984 UTM Zone 11N. 

� Click OK on the Data Frame Properties dialog box. 

� If a warning message displays, click Yes on the warning message to apply the new coordinate system. 

� Move your mouse over the display and note the coordinates in the status bar. 

 

This time the x-coordinates are about 480,000 and the y-coordinates are near 3,700,000. These numbers are almost 

identical to those for the Hydrants layer. You have a match. 

 

In Step 4, you used ArcCatalog to assign a GCS to the Streets shapefile. For the Hydrants layer, you will now define both a 

GCS and a PCS. 

 

Did you pick the right GCS when you chose WGS84? Probably. Your coordinate values are in the right range, but they would 

still be in the right range had you picked the NAD27, NAD83, or WGS72. Although these GCS’s are different, the differences 

are measured in tens or hundreds of meters—nothing you would notice at this scale. In other words, the fact that your 

coordinates match up confirms that you have chosen the right PCS, but it doesn't prove that you've chosen the right GCS. 

WGS84 is probably the right GCS simply because the data has been captured recently with GPS units, and GCS units 

typically base their coordinates on the WGS84 datum. 

 

Step 11 - Copy the Hydrants shapefile 

� Exit ArcMap without saving your changes. Exiting ArcMap releases a hold (lock) on the Hydrants shapefile. You 

have to do this in order to assign the spatial reference in ArcCatalog. 

� Make ArcCatalog active. 

� In the Catalog tree, open the Datums\AssignCS folder. 

� Copy the Hydrants shapefile to your Datums\MyWork folder. You don't have to rename it.  

 

Step 12 - Assign a spatial reference to the data 

� In the Catalog tree, right-click the copied shapefile (the Datums\MyWork folder should be selected in the tree) and 

choose Properties. 

� Click the XY Coordinate System tab. 

� Expand the Projected Coordinate Systems folder, then UTM > WGS 1984 > Northern Hemisphere. 

� Click WGS 1984 UTM Zone 11N. 

 

The coordinate system name and details appear in the Spatial Reference Properties dialog box. Note that the Details box 

contains both the PCS information (projection name and parameters) and the GCS information (angular unit, prime 

meridian, and datum). 

 

� Click OK. 

 

The shapefile now has an extra file called Hydrants.prj that contains its coordinate system information. If you want, you can 

confirm this in Windows Explorer. 

 

In this exercise, you created .prj files for two shapefiles. These operations are permanent when you complete them. 

 

In the next exercise, you will use the Streets and Hydrants shapefiles that now have spatial references assigned, and a new 

Parcels shapefile. Each of them will have a different GCS, so you will get to see how datum transformations work. 

 

� Close ArcCatalog. 



Exercise 9: Transform Coordinate Systems 

 

A new data frame has no coordinate system. When you add your first layer to it, the data frame takes on that layer's 

coordinate system. For any subsequent layers that you add, one of two things happens. If the new layer's coordinate system 

already matches the data frame, the layer is added without question. If the new layer's coordinate system is different, you 

get a GCS warning and ArcMap changes the coordinate system of the new layer to match the existing one. This operation is 

called a datum transformation (or coordinate system transformation). For all new layers that you add, ArcMap does these 

transformations automatically so that layers with different GCSs can be displayed together. (The transformations are done 

"on the fly," meaning they are applied only inside the data frame; the GCSs of the datasets on disk are not changed.) 

 

It's great that ArcMap does datum transformations for you, but complications arise because there may be multiple versions 

of a transformation. For example, ArcMap has several formulas that convert from NAD27 to NAD83; each works best for a 

particular region: 

 
Optimal transformation   Location of data 

NAD_1927_To_NAD_1983_6   Canada - Quebec 

NAD_1927_To_NAD_1983_Alaska  Alaska 

NAD_1927_To_NAD_1983_CSRS98_1  Canada - Quebec 

NAD_1927_To_NAD_1983_CSRS98_2  Canada - Saskatchewan 

NAD_1927_To_NAD_1983_NADCON  Conterminous US (not Alaska or Hawaii) 

NAD_1927_To_NAD_1983_NTv2_Canada  Canada 

NAD_1927_To_NAD_1983_PR_VI  Puerto Rico - Virgin Islands 

 

Similarly, there are over 20 different transformations from NAD27 to WGS84: 
 

Optimal transformation  Location of data 

NAD_1927_To_WGS_1984_1  Mean for Antigua, Barbados, Barbuda, Caicos Islands, Cuba, Dominican Republic,  

Grand Cayman, Jamaica, and Turks Islands 

NAD_1927_To_WGS_1984_2  Mean for Belize, Costa Rica, El Salvador, Guatemala, Honduras, and Nicaragua 

NAD_1927_To_WGS_1984_3  Mean for Canada 

NAD_1927_To_WGS_1984_4  Mean for United States (CONUS) 

NAD_1927_To_WGS_1984_5  Mean for United States (CONUS East of Mississippi River and MN, MO, and LA) 

NAD_1927_To_WGS_1984_6  Mean for United States (CONUS West of Mississippi River) 

NAD_1927_To_WGS_1984_7  United States (Alaska) 

NAD_1927_To_WGS_1984_8  Bahamas (except San Salvador Island) 

NAD_1927_To_WGS_1984_9  Bahamas (San Salvador Island) 

NAD_1927_To_WGS_1984_10  Canada (Alberta, British Columbia) 

NAD_1927_To_WGS_1984_11  Canada (Manitoba, Ontario) 

NAD_1927_To_WGS_1984_12  Canada (New Brunswick, Newfoundland, Nova Scotia, and Quebec) 

NAD_1927_To_WGS_1984_13  Canada (Northwest Territories, Saskatchewan) 

NAD_1927_To_WGS_1984_14  Canada (Yukon) 

NAD_1927_To_WGS_1984_15  Panama (Canal Zone) 

NAD_1927_To_WGS_1984_16  Cuba 

NAD_1927_To_WGS_1984_17  Greenland (Hayes Peninsula) 

NAD_1927_To_WGS_1984_18  Mexico 

NAD_1927_To_WGS_1984_21  United States (Alaska - Aleutians East of 180E) 

NAD_1927_To_WGS_1984_22  United States (Alaska - Aleutians West of 180E) 

NAD_1927_To_WGS_1984_30  Cuba 

 

For each datum transformation, ArcMap has to pick a default formula. For the NAD27 to NAD83 transformation, it uses 

NAD_1927_To_NAD_1983_NADCON, which is optimized for the continental United States. If your data happens to lie in 

Alaska or Canada, your features may still not line up properly until you override the default transformation and pick the 

optimal one. 

 

The default NAD27 to WGS84 transformation is NAD_1927_To_WGS_1984_1, which is the optimal transformation only for 

Caribbean data. 

 

In this exercise, you will see how ArcMap applies its default datum transformations and you will learn how to change these 

settings. 

 

Estimated time to complete: 45 minutes 

 

Step 1 - Start ArcMap and open a new map document. 

� Click the Add Data button, navigate to the Datums\MyWork folder and add Streets.shp -- this is the shapefile to 

which you assigned a spatial reference in Exercise 8. (Be sure you are adding data from the Datums\MyWork 

folder) 



Step 2 - Check the data frame's coordinate system 

� Open the Data Frame Properties dialog box and click the Coordinate System tab. 

The coordinate system is set to GCS_North_American_1927. 

� Click the Transformations button.  

 

Since the data frame has only one layer, the "Convert from" and "Into" datums are the same and no transformations are 

listed in the "Using" box. If you know the transformation you want, you can set it up ahead of time; otherwise, you can let 

ArcMap apply a default transformation. 

 

In the next step, you'll add a layer with a NAD83 GCS and let ArcMap set the datum transformation. 

� Click Cancel on the GCS Transformations dialog box and on the Data Frame Properties dialog box. 

 

Step 3 - Add a second layer with a different GCS 

� Click the Add Data button. Navigate to the Datums\TransformCS folder and click to add ParcelsNAD83GRS80. 

 

A warning message tells you that the new layer's GCS is different from the data already in the map. It also tells you that you 

may need to change the geographic transformation in order to avoid alignment problems. 

� Click Close or OK on the warning message. 

 

You need to zoom in to see the parcels. 

� In the table of contents, right-click the parcels layer and click Zoom To Layer. That brings you a bit too close. 

� In the map scale box, type 8000 and press Enter. 

 

Although the two layers have different GCSs, they align nicely. It looks like ArcMap picked the best available datum 

transformation. Now you'll take a look to see which one it is. 

 

Step 4 - Check the datum transformation 

� Open the Data Frame Properties dialog box, click the Coordinate Systems tab, if necessary, and then click 

Transformations. 

In the GCS Transformations dialog box, both GCSs found in the data frame are listed. 

� Click GCS_North_American_1983, the GCS of the Parcels layer. 

 

ArcMap has transformed the NAD83 datum to NAD27 using the NAD_1927_To_NAD_1983_NADCON formula. As you may 

have seen in the exercise introduction, this transformation is optimized for the continental United States and is therefore 

the best choice for your southern California data. 

 

� Click the Using drop-down arrow to see all the available transformations. 

 

Some of them have descriptive names, but others don't. Later in this exercise, you'll learn how to use a table that helps you 

find the best transformation for your area of interest. You should always confirm that you are using the optimal 

transformation—even when you don't notice alignment problems in your data display. 

 

� Click Cancel on the GCS Transformations dialog box and on the Data Frame Properties dialog box. 

 

Step 5 - Add a third layer in still another GCS 

� Click the Add Data button. Navigate, if necessary, to the Datums\MyWork folder and add Hydrants. (Again, be 

sure to add data from Datums\MyWork – you want to use the Hydrants shapefile you worked on in Exercise 8). 

� Again, click Close or OK on the GCS warning message. 

 

The hydrant points show up, but not in the correct locations. Each fire hydrant should lie inside a parcel and near its edge. 

These hydrants are shifted to the left by about four parcel lengths. What went wrong? ArcMap's default datum 

transformation is probably not the optimal one. 

Step 6 - Check the datum transformation 

� Open the Data Frame Properties dialog box, click the Coordinate Systems tab, if necessary, and click the 

Transformations button. 

� In the Convert from pane, click GCS_WGS_1984 (the GCS of the hydrants layer). 

The default transformation applied by ArcMap is either listed as None or as NAD_1927_To_WGS_1984_1. In either case, the 

data is not in its correct location. 

� Click the Using drop-down arrow to see the other transformations. 



There are over twenty. How do you know which one to use? If there were only a few, you could try them all, but with so 

many choices that would take a while. Fortunately, ArcMap comes with a file called geographic_transformations.pdf that 

lists supported datum transformations and the areas for which they are optimized. This file has also been included in the 

data you downloaded for these exercises. 

 

Step 7 - Find the best transformation for your area 

� Open Windows Explorer (My Computer). 

� In Windows Explorer, navigate to the Datums\TransformCS folder. 

� Double-click geographic_transformations.pdf to open the PDF file. You might need to click the Rotate Clockwise 

button to change the orientation of the document. 

 

The file provided here is one of three files that can be found in the ArcGIS\Documentation folder. These files contain 

information related to coordinate systems and geographic transformations supported by ArcGIS: 

 

geographic_coordinate_systems.pdf - This file lists the parameters (e.g., spheroid, datum, prime meridian, and angular 

unit of measure) of every supported geographic coordinate system. It also lists geographic areas and shows the GCS 

associated with each. 

 

geographic_transformations.pdf - This document lists the datum transformations supported by ArcMap. It gives the 

values for three- and seven-parameter based transformations and the names of grid-on-grid transformations for 

specific areas of interest. 

 

projected_coordinate_systems.pdf - This file lists every supported map projection according to the geographic area it 

best represents. (In other words, the part of the world for which this projection minimizes distortion.) 

 

� Navigate to page 34 of the geographic_transformations.pdf document. 

At the bottom of the page begins a list of transformations for North America. The left column shows the area for which the 

transformation is best suited and the right lists the transformation. 

 

� Scroll down to page 37 and locate United States (contiguous states west of Mississippi River) in the left column. 

The transformation for this region, and the one that therefore best fits your California data, is NAD_1927_To_WGS_1984_6. 

If the transformation is listed twice, choose either one. 

 

Step 8 - Apply the new datum transformation 

� Close Adobe Reader and make ArcMap active. 

 

In ArcMap, the Geographic Coordinate System Transformations dialog box should still be open. 

� From the Using drop-down list, choose NAD_1927_To_WGS_1984_6. 

� Click OK on the GCS Transformations dialog box and on the Data Frame Properties dialog box. 

It looks like the new transformation has fixed the problem. The fire hydrants have shifted to the right and appear to be 

positioned inside parcels. 

 

But is everything really as good as it seems? 

 

Step 9 - Check your results 

� Click the Zoom In tool Zoom In on the Tools toolbar. 

� Zoom in on the fire hydrant in the bottom cul de sac (in the lower left corner of the parcels data). You may have to 

use the tool a few times to see that the hydrant is not really inside the parcel but out in the street. 

 

Next, you'll identify how far you'd have to move the hydrant to get it back inside the parcel and off the street. 

To make the measurement you should be zoomed in really close. 

� Set your map scale to 1:100. 

� In the Measure window, set the Distance Units to Feet. 

� Click on the hydrant and then click inside the parcel to get a distance. 

 

It is about one and a half to two feet from the hydrant to the edge of the parcel. So the hydrant points are still off by that 

amount. (It would be nice to have a precise air photo to compare positions, but this is a new subdivision and air photos 

don't yet exist for it.) 

 

 



Step 10 - Solve the problem 

Getting back to the reason for the problem, take another look at the datum transformation. 

� Open the Data Frame Properties dialog box, click the Coordinate System tab, and click Transformations. 

� In the Convert From pane, click GCS_WGS_1984. 

 

Note that the method is Geocentric Translation. This is a three-parameter transformation, which is a relatively low-

accuracy transformation—especially when you're going from a local datum to an earth-centered datum (because the 

origins of the two coordinate systems are far apart). 

 

An easy solution would be to change the data frame's coordinate system so that the NAD_1927_To_WGS_1984_6 

transformation doesn't have to be applied. You can do this by changing the data frame's GCS from NAD27 to NAD83. What 

does that do for you? First, it still lets you apply the very accurate NADCON transformation to align the streets and parcels. 

Second, it lets you transform between WGS84 and NAD83 (instead of between WGS84 and NAD27) to align the parcels and 

hydrants. This is an advantage because WGS84 and NAD83 are both earth-centered datums with similar specifications; 

consequently, this transformation is more accurate. 

 

� Click Cancel on the GCS Transformations dialog box. 

 

Step 11 - Change the coordinate system of the data frame 

� Make sure the Data Frame Properties dialog box is open and the Coordinate System tab is selected. 

� Expand the Geographic Coordinate Systems folder, then the North America folder. 

� Scroll down and click NAD 1983. 

� Click OK on the Data Frame Properties dialog box. If you get a GCS warning, click Yes. 

 

The hydrant has moved inside the parcel boundary, where it should be. 

 

� SCREEN SHOT 9.11: Go to Layout View, add a title “SS 9.11 – Hydrant”. Export the layout as a JPG file and 

insert it into your Word document. 

 

Step 12 - Check your results again 

� Click the Measure tool, if necessary, and measure the distance from the edge of the parcel to the new location of 

the hydrant. 

It's about half a foot away. If you like, check the locations of some other hydrants to make sure they are all within parcel 

boundaries. 

� Click Cancel on the GCS Transformations dialog box and on the Data Frame Properties dialog box. 

 

It may seem like you used a little sleight-of-hand, but all you really did was take advantage of the fact that some datum 

transformations work a little bit better than others. Here are a few points to remember: 

 

* Conversions between NAD27 and NAD83 are highly accurate because they use a grid-on-grid transformation 

method. 

* Conversions between NAD83 and WGS84 are accurate because both datums are earth-centered and have similar 

specifications. 

* Geocentric translations between local and earth-centered datums (like NAD27 and WGS84) may lack the desired 

accuracy at large scales. 

 

Step 13 - Save and close the project 

� From the File menu, choose Save As. 

� In the Save As dialog box, navigate to your Datums\MyWork folder. 

� Name the file myTransform and click Save. 

� Close ArcMap when you are finished. 

 

Email your completed Word document to michael.trust@umb.edu. 

This assignment is worth 45 POINTS. 


